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Configuration & Library

Key Points:

Define Part Configurations

Define Assembly Configurations

Create Library Based on Configurations
Create Library by Excel Data

Reuse the Library

T

Library design consists of part seriation and library definition, which can speed up the design

process, save development time, increase productivity and reduce mistakes.

Configurations allow designers to create multiple variations of a part with different part
attributes, variables, features and dimensions, or different version of an assembly with

different part configuration, component status and constraint parameters.

The library can be easily created based on configuration data or defined by the excel file.
During the design process, you could select the suitable part or assembly to reuse the library to
raise efficiency.

1.1 Build the Parametrical Model

Generally, the parametrical model should be created before defining part configurations for a
3D model. Take a nut as an example

Figurel Nut Model and Key Parameters

Refer to the following main steps to build the nut parametrical model.

STEP 01| Define the needed variables in equation manager, as shown in Figure?2.
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'@ Equation Manager L2 EE
—Expression List
Filter  User Defined - Ow | Dw | @E ||
Mame Expression Value | Unit |T],rpe |
4 = Nut_Hex IS0_4035
s 4 4 i Mumber
I Length 1.2 1.2 Fnrm Mumber
I Angle 30 30 deg Mumber
2 Pitch 0.4 0.4 FAm Murmber
N 2 2 mm Mumber

Figure2 Defined Variables

STEP 02| Build the model base with the sketch and extrude commands.

wtrud _Base;dﬁ— Length=1.20

_d0=5=4.00

Figure3 Model Base

STEP 03| Create the thread-hole feature. Set the hole parameters with the variables, as
shown in Figure4.

¥ Hole Specification ¥ Specification
Hole shape Simple - — 1 M=
¥ Thread i T
Type Custem - | "%, ‘ H1
Diameter D mm o - I ' l
© Pitch Pitch  mm ° | & = Tfﬁ
(") Thrds/Unit ¢ s E Dia (D1) D ———
Depth type Custom - Depth (HL) Length mm © | -
Depth Length  mm - [ B~ | gng Blind -
Tip 180 deg 2 & -

Figure4 Parametrical Nut Model
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1.2 Introduction of Config Table

1.2.1 Configurable Items for the Part

In part tab of config table, all part configurable items are listed on the left side of the dialog,

including standard attributes, user attributes, expressions and history.
e Configure attributes and expressions

Check the standard attribute or user attribute, and the expression, then data can be
resetted in the default configuration.

¥¥ Config Table

Part Assembly 4| Filter Al -
Filter All = Al - Stock size S(mm) Length(rmm)
Name Descriptiv| Default | R2.32mm*L1.2mm £ 4 T 1.2

4 g Nut_Hex IS0_4035
» B standard attribute
4 {5 User attribute
| Stock_size
4 {5 Expression
W S
4 T |enath
I Angle
T Pitch
LD
- B3 History
| 3 Mew config | | Copy config | Delete config | Manage key itemns

Figure5 Configure Attributes and Expressions
e Configure the features and feature dimensions

Check the feature or feature dimension to add them into the configuration. In the

configuration table, checking the feature means that this feature is suppressed in this

configuration. The feature dimension could be directly modified.

F|
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¥¥ Config Table
Part Assembly 4 Filter All i
Filter Al T | Al M Extrudel Basze |rudel_Base_d3(m
Mame Descri Default O 2 T
4 9 History
[ xy
Hxz —
H vz /"' Filter Al -
p %2 Sketchl
7 :"' Extrudel Base I Extrudel_Basze | rudel_Base_d3(m
Extrudel_Base d3 = Default I 3 ¥
Extrudel Base_d4
> & Sketch2
B Y Revolvel Cut
> ] 1 Holel - suppress the feature1
1| iy | » Mew config

Figure6 Configure Features and Feature Dimensions

1.2.2 Configurable Items for the Assembly

For an assembly, the component status and constraints are configurable, including suppressed

/un-suppressed component, part configuration, component color, position, enabled/disabled
constraint and constraint value.

¥ Config Table

2 2R
Part Assembly 4 Filter  All -
Filter Al T LAl - Zheese Head_I50 | Cheese Head IS0 | Zheese Head 150 . Coincident 1(mm)
: Coincident 1
. Suppress Part Cenfig Color Offset
Name Descriptin
4 = Ass Screw Nut Default O M2-13 & I:' O 1 T
4 . Screw_Cheese Hea...
Part Config
Color
Position

b [ ] & Nut_Hex 150_4035_1
a £ Constraints
= @ Cencentricl (N...
4 [J] € Coincident 1 (5¢..
[¥] Offset
[¥] Minimum
[¥] Maximum

Mew config | Copy config | Delete config Manage key items | | L

Figure7 Configure Components and Constraints
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1.3 Define Part Configuration

Take the nut as example, we will create a part seriation with different size. There are two

methods to call config table dialog.

& ]

=

Config
1) Tool Ribbon Toolbar->Insert-> Table

2) Right click the blank area of history manager -> Config Table

Manager 3
9 Show Maost -
FO [ m
e Mut_Hex 150 4035
-’ B3 solid() E. Redefine Last
&l 4 &= Expression(3) <; Regen
L S=4mm
_— I Length = 1.5 mm il Close All kems
N7 . .-
. & Angle = 30 deg §f  Unsuppress All
I Pitch = 0.4 mm
T } T D=2mm I Delete Suppressed
= 4 {5 History £~ Conditional Suppress
ﬂ [ xv i Encapsulate
) [ xz
‘ = g Defeature
4 vz
& (-)Sketchl % Config Table
¥ Extrudel_Base T kT
&% (-)Sketch2 = P10
Jly Revolvel Cut Ew  Record State
I Holet \f History Folder
- MODEL STOP HERE ----

Figure8 Config Table

1.3.1 Define Default Part Configuration

STEP 01| In config table, expand the expression and then check the needed variable.

STEP 02| Set the value as the default configuration.
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%P Config Table =]
Part  Assembly d Filter Al -
! T Al v S{rmm) Length({mm) Pitch(mm) D(rmm)

— e 4l > PiTY PiF -

4 = Mut_Hex 150_4035
> B3 Standard attribute
4 5 Fxpression
Js
I Length
AL Angle
L Pitch
2D
> History

\
¥

4 Il | » New config | Copy config | Delete config  Manage key items | (20| Do @ | <3

oK Cancel Apply

Figure9 Define the Default Configuration

1.3.2 Create All Part Configurations
Many different methods are provided to create the configurations. All will be introduced by
this case.
Method1: New config

STEP 01| Click “New config” button to create a new config, give a name “D2” or add the needed
description.Then a config D2 with the default parameters is added.

STEP 02| Set the parameters value if necessary.

%¥ Config Table =
Part = Assembly 4| Filter ANl -
k=] Al ” LA N S(mm) Length(mm) Pitch(mm) D{mm)
Mame Descriptin] | Default | 4 15 T 04 PAP Fa
4 = Mut Hex I50_4035
> B0 Standard attribute R . 104 22 =
> B0 Expression
> B3 History ¥ New Config 9 =

Config name D2

Description  Thread Diameter Value

QK Cancel
4 1 | boNewcnnfig A=

oK Cancel Apply

Figure10 Create a New Configuration
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Method2: Copy config

STEP 01| Select a config, then click “Copy config” button to copy a config with the same data.

¥¥ Config Table (=]
Part Assembly 4 Filter  All v
! " Al v S(mm) Length(mm) Pitch{mm) Dimm)
Mame Descriptin Default | 4
4 = Nut_Hex 150_4035
> [0 Standard attribute o B2 4
> B Bxpression D21 |4 15 04 AP k3l
> [ History
4 il | » New config | Copy config  Delete config  Manage keyitems | [ | 0 @ £ &F

oK Cancel Apply

Figure1l1l Copy a New Configuration

STEP 02| Double-click the config name to rename it as “D2.5”".

STEP 03| Set the new parameter value for the config D2.5, as shown in the image below.

¥¥ Config Table =1
Part Assembly 4 Filter  All v
lter] Al M EL . S{mm) Length{mm) R Dimm)
Mame Descriptin Default | 4 T 15 T 04 AP T
4 = Nut_Hex ISO_4035 N N N N
> [ Standard attribute D2 4 15 04 2
> B Expression D25 |5 T 16 045 25 T
> B History
1] Il | » New config | Copy config | Delete config | Manage keyitems | [ o B 23 &

0K Cancel Apply

Figure12 Set the Config Parameters

Method3: Add new configurations by exporting/importing excel file
STEP 01| Click export icon to export current data to excel file(Part name_Part Config.xls).

STEP 02| Add other configurations data in this part config excel file and save it.

STEP 03| Import the excel data into config table.
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% Config Table
p Filter Al \
S(mm) Length{mm) Pitch{mm) Dirmm)
— 4 P 2los 5 .
Dz 4 ...................................... I s Aty Ay .
D2.5 5 T 16 T 045 T 25 I
D3 55 T 18 T 05 i3 I
D4 7 T 22 T 07 T4 ki3
© 0
Mew config | Copy config || Delete config | Manage key items | 40| & ul
oK Cancel Apply

A B
HHKEYS
<NAME=
<TAG>
H#HCUSTOMS
<NAME=
<TAG>
<MIN>
<MAK =
#H#PARAMETER
S5({mm) SLength{mm) SPitch{mm)
.5 ‘0.4
r r
1.5 0.4
r r
1.6 0.45
5 1.8 0.5
r r
2.2 0.7

[T T B B R I o N I N R
[a]
o
m
3

=
o

SD{mm)
Default
D2

3 |D2.5

D3

D4

T I I B
B o T
n

@

Figure1l3 Export and Import Excel Data

More importantly, it’s easy to share the defined configuration data by exporting and importing

tools.

Method4: Edit configurations data in temporary excel file

STEP 01 Click excel icon to directly edit configuration data in a temporary excel file.

STEP 02| Add other configurations data in the excel, such as Config D3 and D4.

STEP 03| Save the excel, then config table is automatically updated.

Notes: This temporary excel file is different with the exported config excel file. Only config table

data is recorded, as shown in the image below.

% Config Table =l
» Filter Al v
S{mm) Length(mm) Pitch{mm) D{mm)

Default | 4 T 15 T 04 L2 yid
D2 4 X 15 T 04 . 2 T
s 5 ..................................... - e e T .
(1]

Mew config || Copy config | Delete config | Manage key items | |20 | & nl o=

QK Cancel Apply I@

®[a]s-

= Config Tablexlsx - Microsoft... ? B - O %X
ZIMIEW-OME INSER  PAGEL FORM  DATA REVIE VIEW OrchidJin ~
D17 - 2 v
A B C D E F G -
1 $S(mm)  SLength(n SPitch{mn SD{mm)
2 Default 2 .5 0.4 2
r r r r
3 D2 4 1.5 0.4 2
r r r r
4 |D2.5 3 1.6 0.45 2.5
5 D3 5.5 1.8 0.5 3
& D4 7 2.2 0.7 4 e
g
g9
10
11 -
Sheetl (3] 1 ¥

Figure14 Edit Configuration Data in Excel

How to quickly add a group of similar configuration data?

In method4, during adding configuration data in the temporary excel file, you could add a
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group of data in a cell separated by a comma. After saving, multi- configurations are

automatically created, as shown in the image below.

H ©- = Config Tablexlsk - MicrosoftE.,. 7 H - 0O X @ Config Table PR
FILE HOME IMSERT PAGEL FORM DATA REVIE VIEW OrchidlJin - p Filter  All b
% S(mm) % Pitchimm) | %  D(mm)
F14 - fe v
104 &2 I
A E C o} E F -

1. 0. T T
1 35(mm)  SLength(n SPitch{mn SD{mm) b2 4 15 04 2
2 Default 4 1.5 0.4 2 D25 5 T 16 045 J 25 S
3 b2 2 L3 04 2 D3 6 18 205 2 k4
4 D25 3 1.6 0.45 2.5 . .
5 D3 7] 1.8 0.5 2,2.5,3,3.5 e e D31 i T 18 205 T 25 Ea
[
5 k D32 |6 T18 05 I3 bl
8 D33 6 T 18 A 0.5 135 T
9
10
11 - e New config || Copy config | Delete config | Manage keyitems | [ [0 | @] <> $2

Sheetl ® [ 3

READY & mo- 1 + oK Cancel Apply

Figurel5 Add a Group of Data in a Cell

1.3.3 Verify and Activate the Configuration

—

Click the verify icon L

in the right corner to verify the configuration data.

Select one configration or all configurations, then click “Verify” button to verify data. If the data

is incorrect, the verification will be failed.

0K

¥¥ Config Verify =t ¥¥ Config Verify ==
Part Config Verify Result Failed Part Config Verify Result Failed
Default Unverified Default Success
D2 Unverified D2 Success
D2.5 Unverified 02.5 Success
03 Unverified 03 Success
D4 Unverified 04 Success
Mo Preview

Verify

| OK

Figure16 Verify the Configurations

So far, four different configurations are created. In history manager, any part configuration can

be activated by double click.
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Manager 23

$_ Show Most hd

"9 B Nyt Hex ISO_4035

1 B3 solid(1)

Ej [+ EIExpressinnl[S]

4 3 Part Config(5)

—= ": Default

2 =HY

B D25

E B D3

B D4

4 9 History
[ xv
[Hxz

Figurel7 Activate the Part Configuration

Note: After modifying the data in the config table and before clicking “Apply” button, the old data
can be recovered by clicking “Reload part config from the file” button.

Mew config | Copy config || Delete config | Manage key items | |20 | & nﬂ f} ;

oK Cancel Apply |Reload part cenfig from the file
|

Figure18 Data Recovery

bl i

"y

Is it possible to directly configure the dimension or feature to the configuration?

In the modeling level, all sketch dimensions and feature dimensions both can be directly

configured. Right click the dimension or feature to configure it, as shown in image below.

Manager E3
. | Show Most L
o

= Partd0l
b E3Selid)
Ej [ DExpression(E]
4 {3 Part Config(2)
— B Default
I'jl :‘, Samll
4 {3 History
@ [H xv
Hxz
MHvyz
2 @ (-)Sketchl
g EBxtrudel _Base

I8 Holel I Suppress
{ === MODEL STH ™ Configure Feature I

Pick from List

Show/Hide Dimension 7 :

[} 5]

wi  Modify Value

I ™ Configure Dimension
Convert to PMI

Figure19 Directly Configure Dimension or Feature
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1.4 Create Part Library Based on Configurations

Firstly, let’s see the display effect of the library reuse. Then we could get a general idea of the
library design. When adding library part, the designer chooses the needed part by choosing the

key parameters (and defining the custom parameters).

%Y Add Reuseable Part

v File
Nut_Hex_ISO_4035.Z3
Nut_Hex_ISO_4035

v Legend

10.7772 mm

» Key Parameters
» All parameters

p Settings

e

| v Key Parameters

|

Name Value

Thread Diameter 2

Pitch 04

Head Across Flats 4

v Custom Parameters
Name Value

Thickness 12

v All parameters
|| Show all parameters

v Settings

Instance name Nut_Hex_ISO_4035_Default .~

(] Create the instance in a new file

oK Cancel

|| Insert the instance as a shape

Figure20 Library Application

So for the library definition, key parameters and legend must be defined. Custom parameters is

optional.

1.4.1 Set Key Parameters

Based on the defined configurations, the first step of library design is setting key parameters.

STEP 01| Open the config table.

STEP 02| Right click the configured item, then check “Key” option. Set “S”, “Pitch” and “D” as key

parameters.

The default order of key items depends on the definition order. In here, the required
order is D-Pitch-S.

11
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¥ Config Table
p Filter  All ¥
S(mm) | Key ch{mm)
Default 4 Custom T2
D2 4= X Delete 3
E— Customize menu
D2.5 S_I'Tv—'zc'vw T 25
D3 55 I 18 05 T3
D4 7 I 22 T 07 4
MNew config | Copy config | Delete config || Manage key items | | &
Cancel Apply

D{mm)

=] ¥ Config Table
Part Assembly
Filter All T Al 7
4 MName Descriptive
M 4 = Nut Hex IS0 4035
I B Standard attribute
T 4 {9 Expression
| LS |7| Configure
4 I |ength =
z I Angle I i
T Pitch Custom
D Custemize menu
o [ I» B History
|| &

Figure21 Define the Key Parameters

STEP 03| Click “Manage key items” button to adjust the order if required.

@ Key Itemns Manager LJ ER @ Key Iterns Manager B ER
—Key Items —Key Items
: & : &
Pitch Pitch
] 5
Reset Cancel Apply Reset Cancel Apply

Figure22 Adjust the Order of Key Items

STEP 04 Set the descriptive name for the key items. This step is not necessary.

STEP 05| Click “Apply” button of config table to save these settings.

¥¥ Config Table

Part Assemnbly
Filter All T Al =
Mame Descriptive Mame

4 = Nut_Hex I50_4035
I B Standard attribute
4 {9 Expression

¥¥ Config Table

Part Assembly
Filter All = | Al &
Mame Descriptive Mame

4 = Nut_Hex I50_4035
i B3 Standard attribute
4 {9 Expression

LS . s Head Acraoss Flats
T Length double click T |ength
A Angle I Angle
I Pitch I Pitch
¥ =D ( J—r D Thread Diameter
i B3 History i EJ History

Figure23 Add Descriptive Name

> [w 1<
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1.4.2 Set Custom Parameters

If some parameters value could be customized by the user, this attribute also should be defined
in the config table.

STEP 01| Define the “Length” parameter as the custom parameter, as shown in the image below.

STEP 02| Click “Apply” button of config table to save the setting.

'@ Config Table @ Config Table
Part Assembly ] b Filter Al A
Filter All ~ | Al v S  S(mm) Length{mm} Key
Marne Descriptive Mam Default 4 5_ 1.5 I Custom
4 = Nut Hex 15O 4035
?D S;and;rd a;:tril::lute e 4 2115 I x Ejlj:mize menu

4 Expression D25 5 T 16 I TS s
TS Head Across Flats
|[¥] L Length D3 5.5 18 I 0.5 T3
T Angle v | Coenfigure
T Pitch Key D4 7 22 I 07 T4

T D Custom
o il History

Customize menu

Figure24 Define the Custom Parameters

So far, key / custom parameters and descriptive name both have been defined.

%# Config Table =]
Part | Assembly 4 Filter Al -

Filter All Al - % S(mm) Length(mm % Pitchimm) % Dimm)
Mame Descriptive Mam Default | 4 _7;_ 1.5 7 pa Fap re
4 a Nut_Hex IS0 4035  Sov————————— 2

& B7 Standard attribute D2 4 A 15 T 0.4 zx 2 e
4 5 Expression D25 5 M 1loas 2025 N
LS Head Across Flats
L Length D3 5.5 18 0.5 T3 I
AL Angle
L Pitch D4 7 X 22 07 Ay b
[¥] Z D Thread Diameter
> i3 History

Mew config | Copy config | Delete config  Manage key items | | &1 | & HEJ (7| &

oK Cancel Apply

Figure25 Define Parameters Attributes
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1.4.3 Define Part Table

i

Part
Tool Ribbon Toolbar->Part Table-> = Table -~

STEP 01| Open part table, all part onfigurations data is automatically loaded.

STEP 02| Select one image as the legend of this library part. if it is not defined, the default
legend of Z3 file will be used.

STEP 03| Click “Apply” button to save the setting.

In this table, the order of key parameters match the previous definition.

B¥ Part Table
File | Mut_Hex 150403573 | () Data from excel (0) Data from configurations
Root Mut_Hex IS0 4035 ' Legend ENZW3D Release\2018\Config_Library\Nut,jpg
Keys | Assembly match
MName Increment | Descriptive Name | |4 %  Dimm) %  Pitchimm) | % S(mm)
D Thread Diameter Default | 2 T 04 T4 Til15 14
Pitch D2 2 T 04 T4 T 15 I
S Head Across Flats D25 2.5 T 045 |5 T 16 It
D3 3 L 05 L 55 L 18 I
Dd 4 T 07 i7 L 22 It
1 . Insert Manage items B H L e e
oK Cancel Apply

Figure26 Part Table

Manager
te . . Filter All ~  Preview Graphic
* | Generate instrance with the selected row
Find in Mame
In part table, each different instrance can be created Narne Type
by this command. Select the rows and then click this Nut_Hec 150_4035_D4 part
tool t ) dine inst Mut_Hex 150_4035_D3 Part
ner r nding instances.
00110 generate corespo g Instances Mut_Hesx 150_4035_D2.5 Part
Mut_Hex 150_4035_D2 Part
Mut_Hex 150 4035 Part

14
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1.5 Create Part Library from Excel Data

If the designer doesn’t want to create part library based on configuaration data, he/she could

i

Part
Method 1: Tool Ribbon Toolbar->Part Table-> = Table -

define library data by excel file.

STEP 01| Open part table, select “Data from excel” the option.

¥ Part Table £
File  Mut Hex IS04035.73 ] (©) Data from excel () Data from configurations
Root Mut_Hex_ 1504035 A Legend

Keys | Assembly match

Marme Increment | Descriptive Name | 4| pefault
¥ 7W3D £3
@ There is no valid corresponding excel data for this part.
[Yes] to generate the excel, [No] to cancel.
Yes Mo
1 - Insert Manage items B &E &) 6| 0e| e
0K Cancel Apply

Figure27 Create the Excel file

STEP 02| Click “Yes” button to general a new expty excel file in the same file folder.

= = Mut_Hex_IS04035.xlsx - Microsoft Excel ?T EH - O X
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Orchid Jin =

Al - Je || BHKEYS M
A | 8 | ¢ | D | E F

| #HKEYS

| <NAME=

|<TAG> , . . - -

| srCusTOMS An empty excelfile is created

[ <NAME> :

| <TAG=

[ MmN

| <MAX=

| #HPARAMETER

[0 T S T N
("]
T
-
3

-

11| Default

Figure28 Empty Excel File

15
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STEP 03| Add all data manually in the excel file. All parameters name and formats must be
correct.

H - : Nut_Hex_ISO_4035_Part Config.xs - Microsoft Excel ? B - 0O X%
FILE HOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  Orchidlin ~

F22 h I v
A B C D E F G -

1 HHKEYS

2 <MAME:> SD{mm) SPitch(mm)  $S{mm)

3 <TAG= Thread Diameter Head Across Flats

4 UsTOMS

5 NAME= SLength{mm)

o ETAG=

7 EMIMN=

& KMAX=

g F

10 55{mm) SLength{mm) SPitch{mm) SD{mm)

11 Default a4 1.5 0.4 2

12 D2 a4 1.5 0.4 2

13 D2.5 ] 1.6 0.45 2.5

14 D3 5.5 1.8 0.5 3

15 7 2.2 0.7 a4

16

17 v

Nut_Hex ISO 4035 | Sheetl ) F b
READY F I —m—

Figure29 Add the Library Data in Excel

Notes: This way begins with the empty excel file. It’s easy to make mistake since of spelling or

format mistakes to cause the failure of library definition.

So the recommendation is to start with the default configuration. Next, the better way is

introduced.

i

Config
Method 2: Tool Ribbon Toolbar->Insert-> Table

STEP 01| Open config table, define the default part configuration (chapter 1.3.1).

STEP 02| Set the key/custom parameters (chapter 1.41/1.4.2). The result as shown in the

image below.
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¥¥ Config Table =
Part Assembly 4 Filter Al v
— " Al v %  S(mm) Lengthimm] | % Pitch(mm) | % D(mm)
MNarme Descriptive Name Default | 4 T 15 T4 T2 ki
4 2 Nut_Hex 1504035
&> 7 Standard attri...
4 {5 Expression
T s Head Across Flats
;e 1gth
L Angle
L Pitch
Iy )] Thread Diameter
> B3 History
New config | Copy config  Delete config  Manage key items || (20| Do B | €3 &2
oK Cancel Apply
Figure30 Default Part Config with Key/Custome Parameters
Part
Tool Ribbon Toolbar->Part Table-> = Table -
STEP 01| Open part table, select the option “Data from excel”.
¥ Part Table (=]
File ' Mut_Hex IS04035.23 I (©) Data from excel I () Data from configurations
Root| Mut_Hex 1504035 - Legend
Keys | Assembly match
Mame Increment | Descriptive Name | 4 a D{mm) % Pitch{mm) | %, S(mm) Length{mm
D Thread Diameter Default | 2 T 0.4 T4 15 .
Pitch
S Head Across Flats @ ZWaD 52
@ There is no valid corresponding excel data for this part.
[Yes] to generate the excel, [Mo] to cancel.
1 : | oA || G || De
I Yes I | Mo

Figure31 Create the Excel File

STEP 02| Click “Yes” button to general an excel file in the same file folder.

STEP 03| Open the excel file, as shown in the image below.
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H - ¢&¢- = Mut_Hex 1504035 xlsx - Microsoft Excel T H - 0O %
FILE HOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW Orchid Jin ~ |
117 - Fe v

A B C D E F G H 1 [«]

| Vs 7 | 9 | 7 eSee
2 |<NAME= 5D SPitch 35

3 |<TAG= Thread Diameter Head Across Flats

4 |#ECUSTOMS

5 |<NAME> SLength

& |<TAG>

7 |<MIN

8 |<MAX>

9 |##PARAMETER

10 sD(mm) SPitch{mm) $5{mm) SLength({mm)

11 | Default 2 0.4 4 1.5

12 |

] ) 1 | | _ _ _ _ [+

| Nut_Hex ISO4035 | Sheeti | (3 4] T

READY ' E D ——

Figure32 The Default Excel file with All Formats

STEP 04| Add part library data in the excel file.

H - = Mut_Hex_IS04035 xlsx - Microsoft Excel ? H - 0O X%

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Orchid Jin -

H19 v Fe v
A B C D E F G H I -

1 |#HKEYS

2 |[<NAME> sD SPitch S5

3 <TAG= Thread Diameter Head Across Flats

4 [ #CUSTOMS

5 |[<NAME= Slength

6 |[<TAG=

7 [<MIN=

8 |[<MAX>

9 | #HPARAMETER

10 sD{mm) SPitch{mm) 55{mm) sLength({mm)

11 |Default 2 0.4 4 1.5

12 D2 4 1.5 0.4 2

13 D2.5 5 1.0 0.45 2.5

14 D3 3.5 1.8 0.5 3

15 D4 7 2.2 Q.7 4

16

17 =

Nut_Hex ISO4035 | Sheetl &) 4 »
READY F O ——

Figure33 Add Library Data in Excel

Notes: Compared with the method1, the method?Z is easier and more accurate.


file:///C:/Users/Administrator/AppData/Local/youdao/dict/Application/7.0.1.0227/resultui/dict/
file:///C:/Users/Administrator/AppData/Local/youdao/dict/Application/7.0.1.0227/resultui/dict/
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1.6 Reuse Part Library

After defining the library, we could reuse the library part in any file.

2

Reuse
Tool Ribbon Toolbar->Part Table-> ' Library~

STEP 01| Add the file folder into the library manager.

In this manager, some standard parts are provided, such as ANSI, DME standard parts.

'@ Reuse library manager

| <« = 1+ (D i!'vl?‘ N
v (@ ZW3D Standard Parts 3
v [ ANSI K
v [ Bearings Radial B...
[ Radial Ball Bearing |
|| Compression Spring
» [] Fasteners

£

[ DME

? Reuse Examples

1@Tranmep'ar’cs 5= Create new library
¥ Favorites 7 New folder

Figure34 Add the New Library Folder

STEP 02| Select the z3 file and part model. All parameters are displayed in this table for

preview.
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'@ Reuse library manager =t %9 Add Reuseable Part (=]
w File
| S . # E
AR SRR A i) illEl * Nut_Hex_1504035.23 -
> @ ZW3D Standard Parts Nut_Hex 150 4035 .
3 Reuse Bxamples 7 [;rl 7 ¥ Legend
[_I'.J Config_Librar Ass Scr., Ass Scr. MNut_He..
aTraceParts
¥ Favorites
Object list
MNut_Hex ISO_4035
w Key Parameters
Mame Value
&, Thread Diameter | % Pitch(mm) | %, Head Across Flats| Length(mm)
Thread Diameter 25
Default 2 0.4 4 1.5 pitch 0.45 .
D2 2 04 4 15 Head Across Flats | 5
D2.5 2.5 045 5 16 w Customn Parameters
D3 3 0.5 5.5 18 Hams i)
Length .5}
D4 4 0.7 7 2.2
» All parameters
> Settings
| Cancel ’ QK Cancel

Figure35 Reuse the Library Part

STEP 03| Click “OK” button, then a new dialog pops up. According to the requirement, select the
key parameters or set the custom parameter, then click “OK” to insert the library part.

STEP 04 By default, the instance is inserted as a component into the current file. And the
instance part is created in the current file.

Manager £3 Manager B 3
| Show All A Filter All ~ | Preview Off r

O

™ 4 X Reuse Library Find in  Mame -
) & (-)Nut_Hex 150_4035 D25 |
) MName Type
=[]

INut_Ha(_ISO_4035_D2.5 Part I

-— Reuse Library Assembly
87

Figure36 Result

Settings Parameters:

I . .. }
2 : click this icon to rename the instance name.

| Create the inst i fil . . . . . .
reatE e stance ManEWiE . When this option is checked, the instance part is created in a new

file, as shown in the image below.
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Manager = 25 | 4 ReuselibraryZ3 X | +
& Show All =

o 4 = Reuse Library ‘Q ““ -‘E}‘

7] @ (-)Nut_Hex 1S0_4035_D2.5 ...
oe ¢ |Open Partl

@
3 Insert Compone

?,.-n 4# Change Component

Manager =2 £ Reuse Library.Z3 > + Mut_Hex 150_4035_D2.5.73

m_ Show 4ll -
o
B Nut_Hex_ISO_4035_D2.5

-

-

o

&

i

Figure37 Create the Instance in a New File

Insert theinstance as a shape . ywhen this option is checked, the instance is inserted as a shape

into the current file.

Manager = =% | 4+ Reuse libraryZ3 - [Reuse Library] 3 | +

$_ Show Most hd
FO | m

Reusze Library
Fﬁ Solid(1)
;:] B 51(_ Nut_Hex ISO_4035_D2.5)
PR History

== [ xv

|$| M xz
4 vz

ﬁ B Mut Hex ISO 4035 D2.5
- MODEL STOP HERE -----

Figure38 Insert the Instance as a Shape
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1.7 Define Assembly Configuration

1.7.1 Create Assembly Model with Constraints

Firstly, use the same method to define the part configurations for the screw model.

Pl Expressionil2)
L Body_dia = 2 mm
A Thread = 0.4 mm
L Screw_length = 3 rm
A Head_dia = 3.8 mm
A Head_length =1.4 mm
I Meck_length = 0.8 mm
L Meck_Angle = 30 deg
AL Slot_Width = 0.5 mm
I Slot_Depth = 0.6 mm
At Meck_dia = 1.548 mm
LRl =0.78 mm
A R2 =0.2 mm

4 & History
5 xv

¥ Extrude? Cut
] £d DE Copyl

#y Revolvel _Surf
% Combinel_Add
& Fillet2

U Thread 1

Figure39 Screw Model

¥ Config Table

p Filter  All v
Body_dia{mm)

Default 2 04 o3
M2-13 2 04 T3
M2.5-13 | 2.5 T 045 T3
M3-L4 |3 05 T4
Ma-L5 4 07 )5

New config Copy config

Thread{mm) | Screw_length{mm) | Head_dia(mm)

=

=

Delete config

38 14 08 T
38 14 05 T
45 18 08 T
55 zx 2 1 T
7 T 26 14 T

oK Cancel Apply

Head_length(mm) | Neck_length(mm]| Slot_Width(mm) | Slot_Depth(mm)

0.5

0.5

0.6

0.8

1.2

Manage key items

06 /1548
06 1548
07 1993
T 085 2439
T 11 o322
| D | @8

=

Meck_dia(mm) | DE Copyl

B EEEDO

iy

41

Next, create a new file to assembly the screw and nut together.

Figure40 Screw Part Configurations

STEP 01| Insert the screw and anchor it.

STEP 02| Insert the nut and add the concentric constraint.

STEP 03| Define the coincident constraint and set the offset value as 1mm.

22
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4% Constraint 23
| X E L]
¥ Required

1st entity Fl@Screw _Cheese I-III =2l &
2nd entity F2@MNut_Hex I50_4(] | -=1 &
¥ Constraints
[@lho//LiaH =&
@) Value (") Range

Offset 1 mm 5 & -
Minimum 0 mm ;5T
Maxirmum 0 mm b

Figure41 Coincident Constraint

1.7.2 Define Assembly Configurations

STEP 01| Go to Tool ribbon toolbar -> Config table.

STEP 02| Check the part config and colour item of Screw and Nut components and check the
offset item of coincident1 constraint.

STEP 03| Define the default value for default assembly configuration.

¥ Config Table =l

Part Assembly 4 Filter  All -

EIL=u Al v [ A - Cheese Head 150 | Cheese Head 150 | Mut_Hex IS0_4035 1 | dut_ Hex 150_4035_%| Coincident 1(mm)

Name | Descriptive | Part Config Coler Part Config Color Offset

=l Default | Default - Default v 1 o
4 [ | B Screw_Cheese Hea...
Part Config
Color

Paosition

4 {5 Constraints
i [ | @) Concentric1 (Sc...
4 [ | 4 Coincident 1 (Sc...

Offset
[ I Minimum
[ Maximum Mew config = Copy config | Delete config Manage key items || [ | [l m £ bl

AT

Figure42 Define the Assembly configuration Items

STEP 04 Define other assembly configurations, as shown in the following image. The
operations are similar to the definition of part configurations.
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¥ Config Table (=]

pe— « it

Fitter Al - Al -]

Cheese Head IS0 | Cheese Head 150 | lut_Hex 150 4035 lut_Hex [SO_4035_ Zeincident 1(mm)]
- Part Config Color Part Config Color Offset
Name | Descriptive I|

.2 Default | Default - Default - 1 =
4 [ | B Screw_Cheese Hea... = M2-L3 . I:I'L
Part Config

Colar M25 | M25-13
|| Position
] @t oo 405 W | 'S-S_L
[¥] Part Config M MA-L5
Color
|| Position

4 {5 Constraints
[ ] @ Concentric1 (Sc...
4 [ | 4 Coincident1 (Sc...

Offset
|| Minimum
[ ] Maximum | New config | | Copy config| | Delete config | | Manage key items | IE“E“EI

| 0K || Cancel || Apply |

Figure43 All Assembly Configurations
STEP 05| Click the verify icon in the right corner to verify the configuration data.

STEP 06| In history manager, double click to activate any assembly configuration.

Manager £E
& Show Most -
.ahss_ﬁcrew-hlut
4 & Part Config(s)
% B Default
B m2
= B m2.5
e E M3
B e
O 4 3 History
XY
[ xz
2 vz
- MODEL STOP HERE -----

Figure44 Activate the Assembly Configuration
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1.8 Create Assembly Library Based on Configs

The recommended method is defining assembly library based on configurations.

STEP 01| Define the key/custom parameters in config table. (Refer to chapter 1.4.1 and 1.4.2)

¥ Config Table
Part Assembly 4 Filter Al v
L= A T A T o, Cheese Head IS0_ | Cheese Head ISO. | o, Nut Hex 150_4035_1  Nut_ Hec IS0_4035 1
- Part Config Color Part Config Color
Mame Descriptive |
4 :iAss Screw-Mut Default | Default h Default - 1 i
a
B Screw_Cheese Hea... M2 M2-L3 . D2 . 1 T
/| Part Config
| Color M25 | M25-13 - D25 v 1.2 3
Position
o [ | 8 Nut_Hex 150_4035 1 M3 M3-L4 v b3 v 13 L
7 X
Part Config M MA-LS . D4 - 2 n
#| Color
Position
4 {3 Constraints
@ Concentric1 (Sc...
4 [ | 4 Coincident1 (Sc...
v Mew config | Copy config | Delete config Manage key items | i | o | @ =
oK Cancel Apply

Figure45 Define the Key and Custom Parameters
STEP 02| Open part table, all part configurations data is automatically loaded.

STEP 03| Select one image as the legend of this library. The descriptive name of key parameters

also can be defined in the part table.

STEP 04 Click “Apply” button to save the setting.

¥ Part Table
File | Ass_Screw-Mut.Z3 | () Data from excel (@) Data from configurations
Root Ass_Screw-Mut L7 Legend EAZW3D Release\2018\Config_Library\Screw-Mut.jpg

Keys | Assembly match

Mame Increment | Descriptive Name | O qeese Head 19| & t Hex 150 403 Cheese Head_I50_ | lut_Hex_[S0_4035_
Color Color
Screw_Ch... Screw
Default | Default - | Default A 1 Tt
Mut_Hex_L.. Mut
M2 M2-13 - D2 - 1 19
M2.5 M2.5-L3 - D25 - 12 It
M3 M3-L4 - D3 - 15 I
M4 M4-15 - M - 2 I
1 s Insert Manage items B & % & || Le| e

oK Cancel Apply

Figure46 Assembly -Part Table

25
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1.9 Reuse Assembly Library

2

Reuse
Tool Ribbon Toolbar->Part Table-> Library~

STEP 01] Add the file folder into the library manager.
STEP 02| Select the z3 file and part model. All parameters are displayed for preview.

STEP 03| Select the key parameters or set the custom parameter, then click “OK” to insert.

@ Reuse library manager & 3R @ Add Reuseable Part

#[%] ||+ [o[FE[H]
— Ass_Screw-Nut.Z3

> @ ZW3D Standard Parts . ass excel
# Reuse Examples Ass_Screw-Nut.Z3 Ass_Screw-Nut
o Nut_Hex ISO_4035.23
- —pe— Nut_Hex 1504035.73 Vv Legend
Screw_Cheese Head_1S0_1207.Z3
b Z Desktop
Q TraceParts
¥ Favorites

Object list
rﬁs Screw-Nut
Cheese Head_ISO_| ut_Hex ISO_4035_| “cincicent |
9, teese Head IS %, t_Hex ISO_403 S i
Default Default Default 1 V KeyParameters
Name | Value
M2 M2-13 D2 1
Screw_Cheese Head I.. M2-13
M2.5 M2.5-13 D25 12
Nut_Hex ISO_4035_1(.. D2
M3 M3-L4 D3 15
M4 M4-L5 D4 2 v Custom Parameters
Name | Value
= ; Coincident 1(Offset)(... 1
ancel P

Figure47 Reuse the Assembly Library

STEP 04| By default, the library instance is inserted as a component into the current file.

Manager £X
@ Show All =

Fa 4 .E Reuse Library
4 .E. (=)Ass Screw-Mut_M2
Ej - (f)5crew_Cheese Head IS0 1207_M2-13
&P (=)Nut_Hex 150_4035_D2
- 4 {9 Constraints
"ﬂl @ Concentric 1 (Screw...ut_Hex 150 4035 _D2)
'$' Coincident 1 (Screw... ut_Hex I150_4035_D2)

Figure48 Result

Notes: If you want to learn the meaning of other setting parameters, please go to chapter 1.6.
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1.10 Application of Configurations

During the product design, if there is a part/assembly with some configurations, you could
easily to change the configuration to get different product model or status.

This is a handle case. Three different configurations are defined for this model, involving
dimension variables and feature suppression.

¥ Config Table =
Part Assembly 4 Filter Al T
Filter | All Tl v 1 2 | Sketch? | Extrude5_Boss Morph2| |
Name [Des* | Default 100 10 2 O O O
4 2 Handle =
&> £ Standard attribute Length 180 5 4 0O O O
< {8 Expression Length_smooth | 180 5 T
11
T2 Short 100 T 10 EARN| ] ]
0=z 13
OEr

-
o s

A wm New config || Copy config | Delete config | Manage key items | [z | [1a0 nZI

Figure49 Part Configurations
In following cabinet model, there are two handles as the component.

Right click the handle component, you could change the part configuration.

Manager I = Face Attributes
?ia Show All | ¥ Clone
4 X Cabinet Ass | v pniin Info
- ‘ (f)Cabin: Activate Layer

& P [ & Hinge-Al ©
b [ 2 Hinge-A| ¥ Layer On/Off
== b [F&Door | Copy/Moveto Layer

= I b o= Door |
& Handle | Display Parent B

g & Handle I Configurations g For all same components
S (-)Screw; Customize menu
@ (-)Screw = Default

£z @ scend € 22 G & & To|[V] engtn

& (-)Screw

Length_smooth
> B3 Constraints .

Short

Figure50 Change Part Configuration at Assembly Level

When “For all same components” is checked, one handle is changed, another one is also
changed. The same components keep the same status. If “For all same components” is

unchecked, the same components could have a different part configuration.
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Figure51 Same Components with Different Part Configuration

Summary

Configurations allow designers to create multiple variations of a part with different part
attributes, variables, features and dimensions, or a different version of an assembly with
different part configuration, component status and constraint parameters. Configuration

flexibility in product design gives the efficient design work.

Library design consists of part seriation and library definition, which can speed up the design
process, save time, increase productivity and reduce mistakes.The library can be easily created
based on configuration data or defined by the excel file. During the design process, you could

select the suitable part or assembly to reuse the library to raise efficiency.



